
Integration Guide

© 2000-2012 United Parcel Service of America, Inc. UPS, the UPS brandmark and the color brown  
are registered trademarks of United Parcel Service of America, Inc. All rights reserved. 01/12
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To Upgrade WorldShip:
1. Review this document.

2. �Follow the Pre-Installation Integration Checklist.

3. �Schedule a convenient time for the upgrade.

4. �Upgrade using the CD.

5. Follow the Post-Installation Integration Checklist.

Integrating WorldShip into Your Business
WorldShip integration features enable you to connect the information 
from your current business system with WorldShip. 

Leveraging data from your systems to process shipments enables you 
to reduce key entry to improve consistency and accuracy. WorldShip 
also enables you to export shipment data back to your business 
system to shorten your billing cycle and improve customer service 
with updated tracking information. 

2012 New Integration Features
Import and Export of New Services — Now the Import/Export 
Wizard and Connection Assistant support the import and export  
of the following:

n �Dangerous Goods — The Dangerous Goods Option, Dangerous 
Goods Type, Dangerous Goods Published Charge, Dangerous Goods 
Negotiated Rates Charge and Dangerous Goods CCC Rates Charge  
can be exported at shipment level, and Dangerous Goods Type  
can now be exported at package level.

n �Origin and Destination Area Surcharges — The Origin Area  
Type, Origin Area Surcharge Published, Origin Area Surcharge 
CCC, Origin Area Surcharge Negotiated, Destination Area Type, 
Destination Area Surcharge Published, Destination Area Surcharge 
CCC and Destination Area Surcharge Negotiated can be exported  
at shipment level.

n �Ground Freight — The following Freight Shipment Information 
fields can be imported/exported: 
– Extreme Length
– Freezable Protection
– Limited Access Delivery (replaces Construction Site Delivery)
– Limited Access Pickup
– Pickup Notification for LTL Shipment
– Pickup Notification Reference Number
– Pickup Notification Reference Type
– Pickup Notification Company Name
– Pickup Notification Failed Email Address

The following Freight Shipment Information fields can be exported: 
– Extreme Length Charge
– Freezable Protection Charge
– Limited Access Charge (replaces Construction Site Delivery Fee)

In addition, the following fields can be imported/exported  
for up to five recipients: 
– Pickup Notify Email Address
– Pickup Notify Pickup Scheduled
– Pickup Notify Driver En Route
– Pickup Notify Exception
– Pickup Notify Picked Up

n �Paperless Document Enhancements — The Print Copy  
of Paperless Documents Indicator and Process as Paperless  
fields can be imported/exported.

n �Residential Surcharge — The Residential Surcharge Published, 
Residential Surcharge CCC and Residential Surcharge Negotiated  
can be exported at shipment level.

n �Rates — The Negotiated Rates Indicator can be exported.

n �UPS Returns® Exchange on Outbound Label — The UPS Returns 
Exchange UPS Driver Instruction can be imported/exported.

2011 New Integration Features
Import and Export of New Services — Now the Import/Export  
Wizard and the Connection Assistant support the import and export  
of the following:

n Import Control and Commercial Invoice Removal

n Refrigeration

n UPS Returns® Flexible Access

n UPS carbon neutral

n UPS Returns® Exchange

n UPS Returns® Pack and Collect

Import Control Enhancements — Now you can import Quantum 
View Notify® Notification for UPS Returns® services at both the ship
ment level and package level; before it was available only at the 
package level. Also, now you can import or export Label Creation, 
a new Quantum View Notify Notification type for all UPS Returns 
services, at the shipment level. Finally, importing or exporting  
Return Notification at the package level is no longer supported.

Importing Pro Number into Freight — Now you can use the shipper 
pre-assigned Pro Number throughout shipment processing to uniquely  
identify your shipment from its creation to its destination.
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Pre-Installation Integration Checklist
1. Check Compatibility:

You may have integrated WorldShip with a UPS Ready® (or third-
party) vendor application. Due to changes in the WorldShip 
database structure, these applications may not be compatible  
with WorldShip 2012. 

Do not upgrade until you contact the UPS Ready (or other  
third-party) vendor.

2. Check Operating System and Service Pack:
The WorldShip 2012 upgrade requires that you have either 
Microsoft® Windows® XP Service Pack 2 or higher or Microsoft 
Windows Vista®/Windows 7 to begin installation.

To identify which Operating System and Service Pack you have:

n �Click Start on the Windows taskbar, point to Programs, 
Accessories and System Tools and select System Information.

n �The Operating System version and Service Pack will display  
in the System Information window.

n �If you have Microsoft Windows XP and the Service Pack is lower 
than version 2, select the link below to download and install the 
Service Pack. The PC will be evaluated for available updates 
by Microsoft. Microsoft Windows XP Service Pack 2 will appear 
as a critical update. http://WindowsUpdate.Microsoft.com. 

n �If you wish only to install Microsoft Windows XP Service Pack 2,  
clear all other updates offered.

Memory recommendations: 
n �Windows XP (512 MB) 
n Windows Vista (1 GB)
n Windows 7 (1 GB - 32 bit and 2 GB - 64 bit)

CAUTION: Do not proceed if your system is not at the proper 
Operating System and Service Pack version.

3. Check for Administrative Rights:
Ensure that the user account used to log into Microsoft 
Windows operating systems has full PC administrative rights. 
If unsure, consult the computer technical support staff at your 
company. Due to security enhancements, Microsoft Windows 
Vista/Windows 7 users may be required to authenticate with 
administrative rights during the installation process. The User 
Account Control (UAC) prompt may appear several times during 
installation asking you for permission to let WorldShip install its 
components. You must acknowledge the UAC prompt and allow 
the installation to continue.

Also, if you need to access the WorldShip Support Utility for  
any reason, you must run this utility with administrative rights.  
To perform this task:

n �Click Start on the Windows taskbar, point to Programs and 
UPS, right-click UPS WorldShip Support Utility and select  
Run As Administrator.

4. �Archive WorldShip Shipping History to Improve 
Performance and Processing:
n Start WorldShip.

n Press F3 to open the Shipment History window.

n On the File menu, select Archive Shipments.

n �In the Archive Shipments window, select All Shipments,  
or select All Shipped On or Before and specify a date range,  
and then click OK.

n In the Save As window, click Save.

n �Click Yes in the confirmation window. 
�Note: The last 14 days of history will not be deleted, and  
the history that is deleted may be restored at any later time 
when needed.

n �Click Done when 100% is reached in the Archive Shipments 
window.

n �Click Yes in the window that appears requesting the database 
backup to be performed.
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5. �Check for and Disable Anti-Spyware, Anti-Malware  
and Virus Scanner Software:
Anti-spyware, anti-malware, and virus scanner software  
may conflict with the WorldShip 2012 installation.

6. Check for Workgroup Setup Concerns:
n �Only one WorldShip Workgroup Administrator is allowed.

n �Only the Workgroup Administrative workstation’s language will 
be available for Workgroup Remote workstations. If a Workgroup 
Remote workstation has a need for a WorldShip 2012 installation 
in another language, the user will need to install as a Single 
workstation and should be cautioned that this workstation will 
not benefit from Workgroup-configurable functionality.

n �You may need to configure the firewall software on the 
Workgroup Administrative workstation so the Workgroup 
Remote workstations can connect. See the Post-Installation 
Integration Checklist section for more details.

7. Shut Down Open Applications:
Shut down all other programs running on the taskbar, including 
Microsoft Outlook®, Internet Explorer®, Excel®, etc.

You are now ready to install. Please insert your WorldShip 2012 
CD into your computer, and the upgrade will automatically start if 
your system supports the auto-run feature. If you need information 
on how to upgrade/install, refer to the Support Guides section.

CAUTION: Microsoft Windows Vista/Windows 7 users please  
read below.

At the completion of the WorldShip installation process, your 
PC will be required to restart. After restart, Microsoft Windows 
Vista/Windows 7 may prevent automatic launching of the 
WorldShip application. Please launch WorldShip using the icon 
on your desktop should this happen. If you chose not to place the 
WorldShip icon on your desktop, you may launch WorldShip by 
clicking Start on the Windows taskbar, pointing to Programs  
and then UPS and selecting UPS WorldShip.

Post-Installation Integration Checklist
1. �After the installation, you may need to allow permissions in your 

firewall for the following files to run and ports to accept inbound  
and outbound traffic.

n �Files that may need permission to run are GetHostIP.exe, 
WorldShipTD.exe, wstdsupport.exe, upslnkmg.exe  
and sqlservr.exe.

n �Ports that may need Inbound and Outbound traffic access  
are 80 and 443.

n �Configure the firewall software on the Workgroup Administrative 
workstation so the Workgroup Remote workstations can connect.

	 – �If you use the Windows XP Service Pack 2 firewall, WorldShip 
will configure the firewall for you.

	 – �If you use another firewall, the following settings should  
be configured:

		  • �UDP Port 1434 should be open to incoming traffic

		  • �The WorldShip database instance <drive>:\UPS\WSTD\
MSSQL$UPSWSDBSERVER\Binn\sqlserver.exe should be 
included in the list of firewall exceptions. 

2. �If you disabled any anti-spyware, anti-malware or virus 
scanner software, please enable it.

3. �If you receive a message that WorldShip cannot communicate with 
UPS, consult the computer technical support staff at your company.

4. �For WorldShip Workgroup Administrative workstations: Be aware 
that the WorldShip database will be disconnected if your Workgroup 
Administrative workstation goes into sleep mode. You must close 
WorldShip on both the Workgroup Administrative and Workgroup 
Remote workstations and relaunch the application to resolve this 
issue. If necessary, consult your computer technical support staff 
for questions about sleep mode and how to adjust this setting.

5. �If you have a UPS-supplied printer, restart your printer prior to 
shipping by powering it off and then powering it back on. If you 
are on Microsoft Windows Vista/Windows 7 and you have a UPS-
supplied thermal printer (Eltron®/Zebra®), follow the Installation 
procedure for new Eltron/Zebra drivers.
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Installation Procedure for new Eltron/Zebra drivers:

Note: The instructions below follow the “default view” format  
for Microsoft Windows Vista/Windows 7.

Remove current Eltron/Zebra Printers and Drivers.

1. Click Start on the Windows taskbar and select Control Panel.

2. �Select View Devices and Printers from the Hardware  
and Sound section.

3. �Empty the printer queue for each Eltron, Zebra and UPS thermal 
printer (such as UPS2844, etc.).

4. Go to C:\UPS\WSTD\FOSS\DRIVERS\ELTRON.

5. Double-click ZebraUninstaller.exe.

6. Click the Analysis button.

7. When the analysis is complete, click Clean.

8. Click OK to start the cleaning process.

9. �When the cleaning process is complete, click OK. The Zebra 
Uninstaller will automatically close.

Installation Instructions to Install Eltron/Zebra Thermal  
Label Printers on Microsoft Windows Vista/Windows 7  
with USB printers:

  1. �Plug the USB cable into the computer and printer. Turn on  
the printer. 

  2. Launch WorldShip.

  3. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

  4. Under Label Printer, click Label Printer Setup.

  5. Click Change Label Printer.

  6. �Click Add Printer, choose Eltron/Zebra as your printer type  
and click Select.

  7. �On the Zebra Printer Driver Installation window, click Install  
Zebra Printer.

  8. �In the Selecting the printer window, select Zebra from the 
Manufacturer’s window, and then select the printer from the 
Printers window. Example: Select the Zebra ZP Series-200 dpi  
for the Zebra ZP450. Select UPS Thermal 2844 for the LP2844. 
Click Next. 

  9. �On the Printer Options window, select the correct USB port  
and language. 

10. �Click the Finish button. Windows will automatically install  
the printer drivers. 

11. On the Printer Selection window, click Cancel.

12. Click Change Label Printer.

13. Select the printer name, and then click Select.

14. �On the Label Printer Setup window, select the printer stock 
dimensions and extended area usage. Click Apply.

15. �On the Printing Setup window, click the Doc and Consignee 
label check boxes as needed, and then click the OK button.

16. Turn on the printer. The Found New Hardware wizard appears.

17. �If using Windows XP, select No, not this time and then click 
Next. 

18. �Select Install the software automatically and click Next. 

19. Allow the software to install and click Finish. 
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Installation Instructions to Install Eltron/Zebra Thermal Label 
Printers on Microsoft Windows Vista/Windows 7 with Serial/
Parallel printers:

  1. �Plug the serial/parallel cable into the computer and printer.  
Turn on the printer. 

  2. Restart your PC.

  3. Launch WorldShip.

  4. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

  5. Under Label Printer, click Label Printer Setup.

  6. Click Change Label Printer.

  7. �Click Add Printer, choose Eltron/Zebra as your printer type  
and click Select.

  8. �On the Zebra Printer Driver Installation window, click Install  
Zebra Printer.

  9. �In the Selecting the printer window, select Zebra from the 
Manufacturer’s window, and then select the printer from the 
Printers window. Example: Select the Zebra ZP Series-200 dpi  
for the Zebra ZP450. Select UPS Thermal 2844 for the LP2844. 
Click Next.

10. �On the Printer Options window, select the correct port  
and language.

11. �Click the Finish button. Windows will automatically install  
the printer drivers. 

12. On the Printer Selection window, click Cancel.

13. Click Change Label Printer.

14. Select the printer name, and then click Select.

15. �On the Label Printer Setup window, select the printer stock 
dimensions and extended area usage. Click Apply.

16. �On the Printing Setup window, click the Doc and Consignee 
label check boxes as needed, and then click the OK button.

Support Guides
WorldShip provides a User Guide, Installation Guide  
and Functions Shortcut Sheet in PDF format on ups.com®.

To view or print these documents, install the free Adobe® Reader® 
software from adobe.com and then follow these steps:

1. Go to ups.com/worldship.

2. Select your country/language and then click Go. 

3. Select Get WorldShip Support under Get Started.

4. Select View User Guides.

5. View and print the documents as needed.


